Installation Instructions for Hot Fix F90012
Linux for x64

F90012 is a "container" hot fix that contains the following "member" hot fixes that will
update the software components as indicated. See the Container Hot Fixes section in
the Maintenance Install Tool (MIT) Usage Guide for more information about container hot
fixes.

(55010 for SAS Detail Data Store for Insurance 5.4 M1

F88012 for SAS Firmwide Risk Management for Insurance Server 2.1_M1

F89012 for SAS Market Risk Management for Insurance Server 2.1 _M1

F12013 for SAS Risk Management for Insurance Server 2.1_M1

G54010 for SAS Risk Reporting Repository 1.4_M1

F92012 for SAS Underwriting Risk Management for Life Insurance Server 2.1_M1
F91012 for SAS Underwriting Risk Management for P&C Insurance Server 2.1 _M1
G61009 for SAS Risk Management for Insurance Mid-Tier 2.1_M1

Before applying this hot fix, follow the instructions in SAS Note 35968 to generate a SAS
Deployment Registry report, and then verify that the appropriate product releases are installed
on your system. The software components and release numbers should match the list of
software components updated by the individual hot fix installers.

IMPORTANT NOTES

1. Hot fix FO4002 for SAS Risk Dimensions 5.3_M1 is required prior to installing this hot fix.

http://ftp.sas.com/techsup/download/hotfix/HF2/F04.html

2. Files delivered in this hot fix will be backed up during the installation process.
However, it is good general practice to back up your system before applying updates to
software.

3. When applying this hot fix, you MUST use the -silent and the -alwaysoverwrite
options. ANY customizations that may have been made to files included in the hot fix will be
lost. The hot fix installer will automatically back up files for you. After the hot fix has been
installed, use the backup copies to merge any of the customizations that you wish to retain.
Links to manifests are provided in the section below to assist in determining which files will
be overwritten.

4. Take backups of all .spk files prior to importing newer versions or making any updates to
the contents of an existing .spk file. This can be done by first logging into the SAS
Management Console (SMC) using the Administrator (sasadm) user, navigating to the
appropriate folder containing metadata and exporting the folder contents to a uniquely
named .spk file.

5. Configurations and related uncompiled macro files for the following reports will be
updated in this install:


http://ftp.sas.com/techsup/download/hotfix/HF2/Maint_Install_Tool.pdf
http://ftp.sas.com/techsup/download/hotfix/HF2/Maint_Install_Tool.pdf
http://support.sas.com/kb/35/968.html
http://ftp.sas.com/techsup/download/hotfix/HF2/F04.html
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TP-E1
TP-E1Q
TP-E2
TP-E3
TP-E4
TP-E6
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TP-E7B
TP-F1
TP-F1Q
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TP-F3
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TP-F4
VA-C2A
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The following reports from the above list have been migrated to the EIOPA provided CP 11
Final QRT templates:

Assets-D1
Assets-D1Q
Assets-D1S
Assets-D20
Assets- D2T
Assets-D3
Assets-D4
Assets-D5
Assets-D6
BS- C1
BS-C1D
Country-K1
Cover-AlA
Cover-Al1Q
DurLiab
G01

GO03

G04

IGT1

IGT2
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MCR-B4A



MCR-B4B
OF-B1Q
P&L

RC

RE-J1 Basic
RE-J1 Shares
RE-J2 Basic
RE-J2 Shares
RE-J2 Group
RE-J3
SCR-B2A
SCR-B2A_B2C
SCR-B2B
SCR-B2C
SCR-B3A
SCR-B3C
SCR-B3E
SCR-B3G
TP-E1
TP-E1Q
TP-E2
TP-E3
TP-E4
TP-E7A
TP-E7B
TP-F1
TP-F1Q
TP-F2
TP-F3
TP-F3A
TP-F3B
TP-F4
VA-C2B
VA-C2C

The following reports, if already existing on your system will not be available after this
install as the reports have been dropped from the CP 11 Final QRT templates by EIOPA.
Metadata and configurations for the reports have been removed:

Cover-Al
C2_ANALYSIS LF
C2_ANALYSIS_NL
C2_SUMMARY
G10

G15

G20



G30
IGTS
IGT6
TP-E5
TP-E7
VA-C2D

Following reports were added / updated in the metadata per CP9 and CP 11 Final EIOPA
QRT lists:

Assets-D1Q
Assets-D1S
Assets-D20
Assets- D2T
Cover-AlA
Cover-Al1Q
Duration liabilities
Lapses
Participations
P&L Sharing
RE-J1 Basic
RE-J1 Shares
RE-J2 Basic
RE-J2 Shares
SCR_B2A B2C
TP-E7A
TP-E7B
VA-C2A
VA-C2B
VA-C2C

Stored Process (STP) names and descriptions have been updated in the metadata for a
large majority of the reports to align with changes per CP 9 and CP 11 Final EIOPA
templates. These updates can be applied to the system by importing reports.spk. Details of
the import process are available in the section Import updated .spk files.

If you need to retain previous versions of these files, they can be retrieved from backup
locations as needed.

6. As part of this install, support for XBRL reporting has been added. In order to support this
feature, the following tables and columns have been added to the static directory:
Newly added tables:

e XBRL_COMPLEXTYPE
e XBRL_COMPLEXTYPE_ENUMERATION



e XBRL_DIMENSION

e XBRL_FACTELEMENTS
e XBRL_FMT

e XBRL_REPORT

e XBRL_SCHEMA

Columns for the newly added tables:

Table Name

XBRL_COMPLEXTYPE

XBRL_COMPLEXTYPE_ENUMERATION

XBRL_DIMENSION

XBRL_FACTELEMENTS

XBRL_FMT

Column name

CONFIG_SET_ID
VALID_FROM_DTTM
VALID_TO_DTTM
BASE_CD
MAXINCLUSIVE
MAXLENGTH
MININCLUSIVE
NAME_CD
PATTERN_CD

CONFIG_SET_ID
VALID_FROM_DTTM
VALID_TO_DTTM
NAME_CD
VALUE_VAR

CONFIG_SET_ID
VALID_FROM_DTTM
VALID_TO_DTTM
DIMENSION_CD
REPORT_CD
DIMENSIONTYPE
FORMAT_CD
MEMBERTAG
VARIABLE_CD
VARIABLESTAG

CONFIG_SET_ID
VALID_FROM_DTTM
VALID_TO_DTTM
BASETYPE_CD
ELEMENTCODE
ELEMENTNAME
PERIODTYPE
TAXONOMY

TYPE_CD
CONFIG_SET_ID
VALID_FROM_DTTM
VALID_TO_DTTM
FMTNAME

START

REPORT_CD



DATATYPE
DECSEP
DEFAULT
DIG3SEP
EEXCL
END

FILL

FUZZ

HLO
LABEL
LANGUAGE
LENGTH
MAX

MIN

MULT
NOEDIT
PREFIX
SEXCL
TYPE

XBRL_REPORT CONFIG_SET_ID
VALID_FROM_DTTM
VALID_TO_DTTM
DESCRIPTION
REPORT_CD
TEMPLATE_CD
ITEMVAR
VALUEVAR

XBRL_SCHEMA CONFIG_SET_ID
VALID_FROM_DTTM
VALID_TO_DTTM
PREFIX_VAL
REPORT_CD

7. You must have Administrator Privileges on your CLIENT or SERVER machine.

8. All currently active SAS sessions, daemons, spawners and servers must be terminated
before applying this hot fix.

9. This hot fix should be installed using the same userid that performed the initial software
installation.

10. On UNIX systems, you may need to adjust file permissions on all new and updated files to
meet with your sites security guidelines.

INSTALLATION

This hot fix must be installed on each machine where the updated components of the
product, listed above, are installed. The installation process will determine which
components of SAS Risk Management for Insurance 2.1_M1 are installed on each
machine, and apply the appropriate updates.

If the updated components of this product are installed on multiple operating systems, you
must download the hot fix for the appropriate operating system(s) and follow the installation



instructions provided to complete the deployment of this hot fix.
The installer downloaded is F90012la.bin.
When downloading SAS 9.2 hot fix packages, you must choose to Save the hot fix to disk, and

then execute the install from the saved location. Attempting to install a hot fix directly from
the download page results in the error documented in SAS Note 37104.

e To install this hot fix execute F90012la.bin using both the -alwaysoverwrite
and —silent options.

This will initiate the installation wizard, which will guide you through the hot fix
installation process.

Note: If your Windows operating system is Windows Vista, Windows 7 or Windows Server
2008, it may be necessary to install with the “Run as administrator” option. Within the

Start menu’s Accessories folder, right-click the Command Prompt shortcut, and select
“Run as Administrator” option. Next execute F90012la.bin using the -alwaysoverwrite
option.

See the Maintenance Install Tool (MIT) Usage Guide for more details on the installation of
hot fixes. The content of this hot fix is listed in the hot fix manifest. This completes the
installation of F90012. You must perform any "Post-Installation Instructions™ documented
below to successfully complete the deployment of this hot fix.

POST-INSTALLATION INSTRUCTIONS

G55010 for SAS Detail Data Store for Insurance 5.4_M1

F88012 for SAS Firmwide Risk Management for Insurance Server 2.1_M1

F89012 for SAS Market Risk Management for Insurance Server 2.1 _M1

F12013 for SAS Risk Management for Insurance Server 2.1_M1

G54010 for SAS Risk Reporting Repository 1.4 M1

F92012 for SAS Underwriting Risk Management for Life Insurance Server 2.1_M1
F91012 for SAS Underwriting Risk Management for P&C Insurance Server
G61009 for SAS Risk Management for Insurance Mid-Tier 2.1_M1

(55010 for SAS Detail Data Store for Insurance 5.4 M1

1. If you have existing DDS physical tables, take a backup of the data in a different location.
2. Following is the summary of the changes in this hot fix:

Newly added tables:

e ACCOUNTING_TRANS


http://support.sas.com/kb/37/104.html
http://ftp.sas.com/techsup/download/hotfix/HF2/Maint_Install_Tool.pdf
http://ftp.sas.com/techsup/download/hotfix/HF2/F/F90/F90011/xx/lax/F90010la_manifest.html

ACCOUNTING_TRANS_LINE_ITEM
ACCOUNT _PERIOD
ACCOUNT_PERIOD_ASSOC
ASSET_PORTFOLIO_SEGMENT
ASSET_SEGMENT_X_EXPOSURE
BUSINESS_ENTITY

CEDED_LOSS

CLAIM_INJURED
CLAIM_UNIT_X_INJURED
CONTRACT_SECTION_X_RI_CARRIER
CREDIT_FACILITY_CR_MITIGANT
CURRENCY_CONVERSION_RATE
EXPOSURE_PLEDGED
EXTERNAL_ORG_INDUSTRY_CLASS
FRA_INSURMENT_LEG
GL_SEGMENT_BALANCE
GL_SEGMENT_PARAMETER
GL_SEGMENT_PARAM_GROUP
REINSURANCE_COLLATERAL
REINSURANCE_CONTRACT
REINSURANCE_CONTRACT_SECTION
REINSURANCE_COVERAGE

REINSURANCE_COVERAGE_REFERENCE

REINSURANCE_INTERMEDIARY
REINSURANCE_PROGRAM
REINSURANCE_RATE
REINSURANCE_REINSTATEMENT
RISK_DRIVER
RISK_DRIVER_X_EXPOSURE
RI_TRANS_X_CEDED_LOSS
SUB_LEDGER
SUB_LEDGER_BALANCE

TRADE

XL_LAYER
XL_LAYER_X_RI_CARRIER



Newly added columns:

Table Name
ASSET_SEGMENT_X_ EXPOSURE

BOND_INSTRUMENT

CEDED_LOSS

CLAIM_UNIT

COMML_PROP_DETAILS
COMML_VEHICLE_DETAILS
CONTRACT_SECTION_X_RI_CARRIER

CONVERSION_SCHEDULE

COUNTERPARTY

COVERED_PERILS

CREDIT_FACILITY

CREDIT_RISK_MITIGANT
EMBEDDED_OPTIONS

FINANCIAL_ACCOUNT

FINANCIAL_FUND

FINANCIAL_INSTRUMENT

Column Name
FINANCIAL_POSITION_RK

PRINCIPAL_EXCHANGE_FLG
CONVERTIBLE_FLG

CEDED_LOSS_AMT_CHANGE_DTTM

CLAIM_UNIT_CURRENCY_CD

RECOVERY_ESTIMATED_AMT
RECOVERY_RECEIVED_AMT
APPLICATION_RK

APPLICATION_RK
CEDED_LOSS
ANNOTATION_TXT

VALID_FROM_DTTM
VALID_TO_DTTM

MIN_CAPITAL_REQ FLG
SINGLE_NAME_EXPOSURE_FLG
SOLVENCY2_STANDARD_ID

PERIL_RK

CIC_CD UNWIND_MAX_LOSS_AMT
UNWIND_TRIGGER_EVENT_TYPE_CD

PRIM_COLL_ASSET_TYPE_CD
EMBED_OPT_SCHEDULE_LOOKUP_FLG

CIC_CD

INT_PAYMENT_DAY_OF _MONTH_NO
PAYMENT_DAY_OF MONTH_NO
PREPMT_PSA_SPEED RT
RESET_DAY_OF MONTH_NO
UNWIND_MAX_LOSS_AMT
UNWIND_TRIGGER_EVENT_TYPE_CD

PROFIT_PARTICIPATION_PCT
DERIVATVE_HELD_LINKED_FUND_FLG

CIC_CD

INT_PAYMENT_DAY_OF _MONTH_NO
PAYMENT DAY _OF_MONTH_NO
RESET_DAY_OF_MONTH_NO
UNWIND_MAX_LOSS_AMT
UNWIND_TRIGGER_EVENT_TYPE_CD



FINANCIAL_INSTRUMENT_ASSOC

FINANCIAL_INSTRUMENT_CHNG

FINANCIAL_POSITION

FUND_INSTRUMENT

GENERAL_UNIT_OF_EXPOSURE

GL_ACCOUNT

GL_ACCOUNT_BALANCE

GL_SEGMENT_BALANCE

GL_JRNL

GL_JRNL_DETAILS
GL_SEGMENT_PARAM_GROUP
GL_SEGMENT_PARAMETER
INDIVIDUAL
LEGAL_PROT_INSURED_SUBJECT
LIABILITY_INSURED_SUBJECT
OTHER_INSURED_SUBJECT

PERIL

PERS_PROP_DETAILS
PERS_VEHICLE_DETAILS

PHYSICAL_ASSET

PHYSICAL_ASSET_RK

PREM_PAID_PERIOD_TO_DATE_AMT

SWAP_INFLOW_PERIOD_TO_DATE_AMT
SWAP_OUTFLW_PERIOD_TO_DATE_AMT

SWAP_DELIVERED_CURRENCY_CD
SWAP_RECEIVED_CURRENCY_CD

CUSTODIAN_COUNTERPARTY_RK

LEVEL_OF_LOOKTHROUGH_CD
DELTA_RT

UNDERWRITING_MODEL_AMT
UNDERWRITING_MODEL_TYPE_CD

CONTROL_ACCOUNT_FLG

ACCOUNT_PERIOD_RK AS_OF DATE
GL_BALANCE_BASE_CURRENCY_CD

GL_BALANCE_REPT_CURRENCY_CD
REPORTING_METHOD_CD

TAX_RT

AS_OF DT
TAX_RT

REVERSAL_DESC
REVERSAL_REASON_CD
REVERSED_GL_JRNL_ID
ACCOUNT_PERIOD_RK
GL_SEGMENT_GROUP_DESC
PARAMETER_DESC
DECEASED_DT
APPLICATION_RK
APPLICATION_RK
APPLICATION_RK
PERIL_RK
VALID_FROM_DTTM
VALID_TO_DTTM
APPLICATION_RK
APPLICATION_RK

CIC_CD



PORTFOLIO

REINSURANCE_CARRIER

REINSURANCE_COLLATERAL

REINSURANCE_CONTRACT_SECTION

REINSURANCE_EXPOSURE

REINSURANCE_TRANS

REINSURANCE_TRANS_LINE_ITEM

REPO_INSTRUMENT

RF_CURVE_X_RF_GROUP

RI_TRANS_X_RI_EXPOSURE

RISK_FACTOR

RISK_FACTOR_CURVE

RISK_FACTOR_GROUP

RSK_FCTR_X_ANAL_MDL_TRANS_METH

RISK_FACTOR_X_RISK_FCTR_CURVE

SECURITIZATION_INSTRUMENT

SECURITIZATION_POOL

ASSET_PORTFOLIO_SEGMNT_TYPE_CD

PARTICIPATION_LIMIT_AMT
RI_CARRIER_RK
RI_CARRIER_TYPE_CD
RI_NETWORK_ID

EFFECTIVE_DTTM
EXPIRATION_DTTM

GROSS_RETENTION_PCT

CEDING_COMMISSION_AMT
RI_AMT_SHARE
RI_CONTRACT_SECTION_RK
RI_EXP_EFFECTIVE_DT
RI_EXP_EXPIRATION_DT

RI_CONTRACT_RK
RI_CONTRACT_SECTION_RK
RI_REINSTATEMENT_RK
XL_LAYER_RK

LINE_ITEM_TRANS_AMT
RI_CONTRACT_RK
RI_CONTRACT_SECTION_RK

COLLATERAL_TYPE_CD
ROLLOVER_STRATEGY_ID

VALID_FROM_DTTM
VALID_TO_DTTM

RI_CONTRACT_RK
RI_EXP_TRANS_AMT

VALID_FROM_DTTM
VALID_TO_DTTM

VALID_FROM_DTTM
VALID_TO_DTTM

VALID_FROM_DTTM
VALID_TO DTTM

VALID_FROM_DTTM
VALID_TO_DTTM

VALID_FROM_DTTM
VALID_TO DTTM

PREPAY_STRUCTURED_PRODUCT_FLG

RESECURITIZATION_FLG

UNDERLYING_PRODUCT_TYPE_CD
UNDERLYING_COLLATERAL_TYPE_CD



SUB_LEDGER AS_OF DT

SWAP_INSTRUMENT_LEG PAYMENT_DAY_OF MONTH_NO
INT_PAYMENT_DAY_OF_MONTH_NO
RESET_DAY_OF MONTH_NO

TECHNICAL_INSURED_SUBJECT APPLICATION_RK

XL_LAYER CAP_RANGE_1_AMT_TYPE_CD
CAP_RANGE_2_AMT_TYPE_CD
DEDUCTIBLE_1_AMT
DEDUCTIBLE_2_AMT
LIMIT_1_AMT LIMIT_2_AMT

XL_LAYER_X_RI_CARRIER ANNOTATION_TXT
Renamed Columns:

The column ASSET_PORTFOLIO_X_EXPOSURE RK from
ASSET_PORTFOLIO_SGMNT_X_EXPOSURE table had a typo. The column has been
renamed to ASSET_PORTFOLIO_X_EXPOSURE_RK.

Deprecated tables and columns:

A few tables and columns were deprecated from previous versions. They are now
physically removed.

Deprecated Tables

CLAIM_INJURED_DETAILS
REINSURANCE_CLAIM
REINSURANCE_TREATY
REINSURER_X_TREATY
RI_TREATY_X_COVERAGE
RI_TREATY_X_PERILS
SCHEDULE_X_TREATY

Deprecated Columns

Table Name Column Name
ASSET_SEGMENT_X EXPOSURE FINANCIAL_INSTRUMENT_RK
BOND_VOLATILITY_QUOTE TERM_CD
COMMODITY_VOLATILITY_QUOTE TERM_CD

COVERED_PERILS PERIL_CD



CREDIT_SPREAD_QUOTE TERM_CD

FX_FORWARD_QUOTE TERM_CD
FX_VOLATILITY_QUOTE TERM_CD
INDEX_VOLATILITY_QUOTE TERM_CD
INTEREST_RATE_QUOTE TERM_CD
INT_RATE_VOLATILITY_QUOTE TERM_CD
UNDERLYING_TERM_CD
PHYSICAL_ASSET_QUOTE TERM_CD
REINSURANCE_CARRIER PARTICIPATION_LIMIT

REINSURANCE_CARRIER_CD
REINSURANCE_NETWORK_ID
REINSURER_RK

REINSURANCE_COLLATERAL EFFECTIVE_DT
EXPIRATION_DT

REINSURANCE_EXPOSURE CESSION_LOWER_AMT
CESSION_TYPE_CD
CESSION_UPPER_AMT
CURRENCY_CD
FACULTATIVE_REINSURER_RK
REINSURED_AMT_TYPE_CD
RETENTION_AMT RI_EFFECTIVE_DT
RI_EXPIRATION_DT
RI_PREMIUM_BASIS_CD
RI_RISK_BASIS_CD TREATY_RK
ULTIMATE_CEDED_AMT

REINSURANCE_TRANS TREATY_RK
REINSURANCE_TRANS_LINE_ITEM TREATY_RK
RI_TRANS_X_RI_EXPOSURE TREATY_RK

Columns with changed attributes:

Table Name Column Name
ACCOUNT_PERIOD_ASSOC ORDER_NO
CEDED_LOSS CEDED_LAE_CASE_RESERVE_AMT

CEDED_PAID_LAE_AMT

CURRENCY_CONVERSION_RATE CONVERSION_RT



EXTERNAL_ORG

FINANCIAL_INSTRUMENT
FUND_INSTRUMENT
INDEX_QUOTE

INTERNAL_ORG

MARKET_DATA
REINSURANCE_CONTRACT
REINSURANCE_CONTRACT_SECTION

REINSURANCE_EXPOSURE

RISK_FACTOR_X_RISK_FCTR_CURVE
RSK_FCTR_X_ANAL_MDL_TRANS_METH

UNIT_OF_MEASURE

NAICS_CD
sIC_cD

FINANCIAL_INSTRUMENT_NM
LEVEL_OF LOOKTHROUGH_CD
INDEX_CD

NAICS_CD
SIC_CD

DATA DTTM
CEDENTS_CONTRACT _ID
MAX_COVER_PER_RISK_EVENT

RI_PREMIUM_DUE_DT
RI_PREMIUM_PAID_TO DT

VALID_TO_DTTM
CURR_NUM_UNITS

UOM_TYPE_DESC

If you already have existing DDS physical tables, execute the ddls of the tables that have
undergone changes as mentioned in point 2 above from the
<SASHOME/SASFoundation/9.2/misc/insurancedds/insurancedds_5.4M1/ddl/sas
folder.

If you do not have existing DDS physical tables, execute the ddlgen.sas file present in
<SASHOME>/SASFoundation/9.2/misc/insurancedds/insurancedds_5.4M1/ddl/sas
folder.

updated in this hot fix.
4. Copy the files present in

If you already have existing DDS physical tables, migrate data for those tables which are

<SASHOME>/SASFoundation/9.2/misc/insurancedds/insurancedds_5.4M1/metadata/
folder to a location that can be accessed by DI studio client.

Open DI studio and logon as unrestricted user.
If you have existing metadata for DDS, backup the same.
If you do not have existing metadata for DDS, import

insurancedds_54m1_sas.spk followed by insurancedds_54m1 hfl sas.spk,
insurancedds_54m1_hf2_sas.spk, insurancedds 54ml_hf3_sas.spk,
insurancedds_54m1_hf4_sas.spk, and insurancedds_54m1_hf5_ sas.spk,
insurancedds_54m1 hf6_sas.spk and insurancedds 54m1_hf7_sas.spk,
insurancedds_54m1_hf8_sas.spk and insurancedds_54m1_hf9 _sas.spk.



Note that before importing the insurancedds_54m1_hf2_sas.spk, please delete the table
SCHEDULE_X_TREATY from the destination metadata server using DI Studio from the
folder /Products/SAS Detail Data Store For Insurance/DDS5.4_M1/01] INSURANCE
PRODUCT.

8. If you have existing metadata for DDS hot fix1, 2, 3, 4, 5, 6, 7 and 8 on top of 5.4M1,
import insurancedds_54m1_hf9_sas.spk.

Notes:

a. Table ASSET_PORTFOLIO_SGMNT_ X EXPOSURE has been renamed to
ASSET_SEGMENT_X_EXPOSURE. The data if existing in the original table
needs to be migrated to the newly created table. Please note that the column
ASSET_PORTFOLIO_X_ EXPOSURE_RK in the original table is represented
as ASSET_SEGMENT_X_EXPOSURE_RK in the new table.

b. Once all hot fixes have been installed, execute the below code in DI Studio to
delete the metadata for the physically removed tables/columns. The code
below will synchronize table/column metadata as per physical table
structures.

In DI Studio, start the code editor from “Tools” menu and execute below code
with appropriate values of parameters:

Options metapass=""<password for metadata
user>"" metaport=<port number>
metaprotocol=bridge
metarepository="foundation”
metaserver="<metadata server>"
metauser="<metadata user id>";

proc metalib;

omr (library="Detail Data Store”
repname="foundation”); update_rule (delete);
report;

run;

For detailed instructions on creating physical table and importing metadata, please refer to
SAS® Detail Data Store for Insurance 5.4 Second Edition.

F88012 for SAS Firmwide Risk Management for Insurance Server 2.1_M1

You should delete (or rename) the file rmif_pm_cpty_risk.sas found in
SASFoundation/9.2/ucmacros/rmifirmmva/ folder. This file has been incorrectly delivered to
this location. In this package, the most recent version of this file will be correctly delivered to
the following location (misc/rmifirmmva/solution_data_mart/fw_env/methods/). If you do not
delete/rename this file, it should not have any functional impact since the correct file is called



directly.

F89012 for SAS Market Risk Management for Insurance Server 2.1_M1

You should delete (or rename) the file map_regulatory _bond_type.sas found in the

followinglocations:

- SASFoundation/9.2/misc/rmicomnsvr/solution_data_mart/sampledata/mapping
- SASFoundation/9.2/misc/rmicomnsvr/martddl/mapping

F12013 for SAS Risk Management for Insurance Server 2.1_M1

Import updated .spk files:

1. Backup existing metadata.

2. Import delivered SPK files using SAS MC Import/Export SAS Package wizard

a. Import updated analysis.spk for Firmwide Risk Server 2.1

iv.

V.

Vi.
Vii.
Viii.

Xi.

Xil.

Login to SAS Management Console (SMC) as the Administrator
(sasadm) user

Click on the Folders tab

Navigate to the folder Analysis under System -> Applications -> SAS
Risk Management for Insurance -> Firmwide Risk Server 2.1

Next, right-click on the Analysis folder and select Import SAS Package
from the menu

Browse to
<SASHOME>/SASFoundation/9.2/misc/rmifirmmva/Config/Deployme
nt/Packages and select the analysis.spk file.

Select the radio button for All Objects and click Next.

You should see a list of STPs in the window. Click Next and then Next again.
Ensure that you have the correct mappings for the SAS Application
Servers.

Click Next.

On this screen, map source code repositories between original and
target application servers. Choose the path to the
<SASHOME>/SASFoundation/9.2/sasstp/rmifirmmva folder. Click Next.
Review the Summary information and click Next if correct.

Otherwise, click on the Back buttons to make necessary corrections

in earlier steps.

The next screen should show that the import was completed. Click

the View Log button and scan the log for any errors. If the import

was successful, you should see messages such as “The import

process completed successfully” in the log.

Click Ok and then Finish.



b. Import updated configuration.spk for FIRMWIDE Risk Server 2.1

i. Login to SAS Management Console (SMC) as the Administrator (sasadm) user
ii. Click on the Folders tab

iii. Navigate to the folder Configuration under System -> Applications -> SAS Risk
Management for Insurance -> Firmwide Risk Server 2.1

iv. Select all the STPs, right-click and select Delete.

v. Ensure that all STPs have been deleted from the Configuration folder. The
group solvency stored process configuration has been removed.

vi. Next, right-click on the Configuration folder and select Import SAS Package from
the menu

vii. Browse to
<SASHOME>/SASFoundation/9.2/misc/rmifirmmva/Config/Deployment/Packag
es and select the configuration.spk file.

viii. Select the radio button for All Objects and click Next.

ix. You should see a list of STPs in the window. Click Next and then Next again.

X. Ensure that you have the correct mappings for the SAS Application Servers.

xi. Click Next.

xii. On this screen, map source code repositories between original and target
application servers. Choose the path to the
<SASHOME>/SASFoundation/9.2/sasstp/rmifirmmva folder. Click Next.

xiii. Review the Summary information and click Next if correct. Otherwise, click on
the Back buttons to make necessary corrections in earlier steps.

xiv. The next screen should show that the import was completed. Click the View Log
button and scan the log for any errors. If the import was successful, you should
see messages such as “The import process completed successfully” in the log.

xv. Click Ok and then Finish.

c. Import updated analysis.spk for Life Risk Server 2.1

Login to SAS Management Console (SMC) as the Administrator (sasadm)
user

Click on the Folders tab

Navigate to the folder Analysis under System -> Applications -> SAS Risk
Management for Insurance -> Life Risk Server 2.1

Select all the STPs, right-click and select Delete. Ensure that all STPs have
been deleted from the Analysis folder. The reason these STPs need to be
deleted is that a parameter, RR_INPUTS has been added to most of the STPs.
The parameter can be seen by expanding the System parameter group on the
Parameters tab. You should also see a new STP, SLTH_SOLVENCY if not
already added in a prior hotfix install.

Next, right-click on the Analysis folder and select Import SAS Package
from the menu



vi. Browse to
<SASHOME>/SASFoundation/9.2/misc/rmilifemva/Config/Deployment
/Packages and select the analysis.spk file.

vii. Select the radio button for All Objects and click Next
viii. You should see a list of STPs in the window. Click Next and then Next
again.

iX. Ensure that you have the correct mappings for the SAS Application Servers.
Click Next.

X. On this screen, map source code repositories between original and target
application servers. Choose the path to the
<SASHOME>/SASFoundation/9.2/sasstp/rmilifemva folder. Click Next.

xi. Review the Summary information and click Next if correct. Otherwise,
click on the Back buttons to make necessary corrections in earlier steps.
xii. The next screen should show that the import was completed. Click the
View Log button and scan the log for any errors. If the import was
successful, you should see messages such as “The import process
completed successfully” in the log.
xiii. Click Ok and then Finish.

d. Import updated analysis.spk for Market Risk Server 2.1

i. Login to SAS Management Console (SMC) as the Administrator (sasadm)
user

ii. Click on the Folders tab

ii. Navigate to the folder Analysis under System -> Applications -> SAS Risk
Management for Insurance -> Market Risk Server 2.1

iv. Select all the STPs, right-click and select Delete. Ensure that all STPs have
been deleted from the Analysis folder. The reason these STPs need to be
deleted is that a parameter, RR_INPUTS has been added to most of the STPs.
The parameter can be seen by expanding the System parameter group on the
Parameters tab.

v. Next, right-click on the Analysis folder and select Import SAS Package
from the menu

vi. Browse to
<SASHOME>/SASFoundation/9.2/misc/rmimktmva/Config/Deploymen
t/Packages and select the analysis.spk file.

vii. Select the radio button for All Objects and click Next
viii. You should see a list of STPs in the window. Click Next and then Next
again.

iX. Ensure that you have the correct mappings for the SAS Application Servers.
Click Next.

X. On this screen, map source code repositories between original and target
application servers. Choose the path to the
<SASHOME>/SASFoundation/9.2/sasstp/rmimktmva folder. Click Next.

xi. Review the Summary information and click Next if correct. Otherwise,



Xii.

Xiil.

click on the Back buttons to make necessary corrections in earlier steps.
The next screen should show that the import was completed. Click the
View Log button and scan the log for any errors. If the import was
successful, you should see messages such as “The import process
completed successfully” in the log.

Click Ok and then Finish.

e. Import updated analysis.spk for Property Casual Risk Server 2.1

Vi.

Vii.
Viii.

Xi.

Xii.

Xiii.

Login to SAS Management Console (SMC) as the Administrator (sasadm)
user

Click on the Folders tab

Navigate to the folder Analysis under System -> Applications -> SAS Risk
Management for Insurance -> Property Casual Risk Server 2.1

Select all the STPs, right-click and select Delete. Ensure that all STPs have
been deleted from the Analysis folder. The reason these STPs need to be
deleted is that a parameter, RR_INPUTS has been added to most of the STPs.
The parameter can be seen by expanding the System parameter group on the
Parameters tab. You should also see a new STP, NSLTH_SOLVENCY if not
already added in a prior hotfix install.

Next, right-click on the Analysis folder and select Import SAS Package
from the menu.

Browse to
<SASHOME>/SASFoundation/9.2/misc/rmpcmva/Config/Deployment/
Packages and select the analysis.spk file.

Select the radio button for All Objects and click Next.

You should see a list of STPs in the window. Click Next and then Next
again.

Ensure that you have the correct mappings for the SAS Application Servers.
Click Next.

On this screen, map source code repositories between original and target
application servers. Choose the path to the
<SASHOME>/SASFoundation/9.2/sasstp/rmpcmva folder. Click Next.
Review the Summary information and click Next if correct. Otherwise,
click on the Back buttons to make necessary corrections in earlier steps.
The next screen should show that the import was completed. Click the
View Log button and scan the log for any errors. If the import was
successful, you should see messages such as “The import process
completed successfully” in the log.

Click Ok and then Finish.

f.  Import updated reports.spk for the RMI Common Server component

Login to SAS Management Console (SMC) as the Administrator (sasadm)
user

Click on the Folders tab



Vi.

Vii.
Viii.

Xi.

Xii.

Xiii.
Xiv.

Navigate to the folder Reports under System -> Applications -> SAS Risk
Management for Insurance -> Risk Management for Insurance Server 2.1
Select all the Reports, right-click and select Delete. Ensure that all Reports
have been deleted from the Reports folder.

Next, right-click on the Reports folder and select Import SAS Package
from the menu

Browse to
<SASHOME>/SASFoundation/9.2/misc/rmicomnsvr/Confi/Deployment/
Packages and select the reports.spk file.

Select the radio button for All Objects and click Next

You should see a list of Reports in the window. Click Next and then Next
again.

Ensure that you have the correct mappings for the SAS Application Servers.
Click Next.

On this screen, map source code repositories between original and target
application servers. Choose the path to the
<SASHOME>/SASFoundation/9.2/sasstp/rmicomnsvr folder. Click Next.

Review the Summary information and click Next if correct. Otherwise,
click on the Back buttons to make necessary corrections in earlier steps.
The next screen should show that the import was completed. Click the
View Log button and scan the log for any errors. If the import was
successful, you should see a message such as "The import process
completed successfully” in the log.

Click Ok and then Finish.

If required, selectively import metadata from the backup SPK (refer to Step
1) for only those QRTSs that were customized earlier and are not delivered
in the hot fix.

Import updated system.spk for the RMI Common Server component

iv.

VL.

Vii.

viii.

Click on the Folders tab

Navigate to the folder System under System -> Applications -> SAS Risk
Management for Insurance -> Risk Management for Insurance Server 2.1
Right-click on the System folder and select Import SAS Package from the
menu

Browse to
<SASHOME>/SASFoundation/9.2/misc/rmicomnsvr/Config/Deployme
nt/Packages and select the system.spk file.

Select the radio button for All Objects and click Next

You should see a list of STPs in the window. Click Next and then Next
again.

Ensure that you have the correct mappings for the SAS Application Servers.
Click Next.

On this screen, map source code repositories between original and target
application servers. Choose the path to the
<SASHOME>/SASFoundation/9.2/sasstp/rmicomnsvr folder. Click Next.
Review the Summary information and click Next if correct. Otherwise,



click on the Back buttons to make necessary corrections in earlier steps.
X.  The next screen should show that the import was completed. Click the
View Log button and scan the log for any errors. If the import was
successful, you should see a message such as "The import process
completed successfully” in the log.
xi.  Click Ok and then Finish.
xii.  You should now see
1. Anew "Job name" parameter in the Parameters tab for the
REPORT_OPTIONS STP if you had not installed F90004 or
F90005.
A new parameter for XBRL generation.
3. A new "Verbose logging" parameter in the Parameters tab for the
REPORT_OPTIONS STP

no

h. Import updated utilities.spk for the RMI Common Server component

i. Login to SAS Management Console (SMC) as the Administrator (sasadm)
user
ii. Click on the folders tab

iii. Navigate to the folder Utilities under System -> Applications -> SAS Risk
Management for Insurance -> Risk Management for Insurance Server 2.1

iv. Depending on which hotfix was last installed, follow the steps in the
appropriate section below followed by those in the Common Steps section
to complete the import.

F90006 (or more recent) installed

v. Right-click on the folder named Data Management and click Delete
vi. Next, right-click on the Utilities folder and select Import SAS Package
from the menu
vii. Browse to
<SASHOME>/SASFoundation/9.2/misc/rmicomnsvr/Config/Deployment/Pa
ckages and select the utilities.spk file.
viii. Select the radio button for All Objects and click Next. You should see a list
of STPs in the window. Click Next and then Next again.
iX. Now, proceed with the Common Steps x. through xv.

F90006 not installed
v. Select the STPs listed below, right-click and click delete

ACCOUNTING_MEASURES



Vi.

Vii.

viii.

Xi.

Xii.

Xiil.

Xiv.
XV.

RE_J1
RE_J2
RE J3
TP E4
TP_E6
TP _E7A
TP _E7B

The reason that these STPs need to be removed is to be able to consolidate
them under a new Data Management folder (which will be installed from
the utilities.spk files) and also because the .sas files they execute have been
renamed.

Next, right-click on the Utilities folder and select Import SAS Package
from the menu

Browse to
<SASHOME>/SASFoundation/9.2/misc/rmicomnsvr/Config/Deployment/Pa
ckages and select the utilities.spk file.

Select the radio button for All Objects and click Next. You should see a list
of STPs in the window. Click Next and then Next again.

Now, proceed with the Common Steps X. through xv.

Common Steps

Ensure that you have the correct mappings for the SAS Application Servers.
Click Next.

On this screen, map source code repositories between original and target
application servers. Choose the path to the
<SASHOME>/SASFoundation/9.2/sasstp/rmicomnsvr folder. Click Next.
Review the Summary information and click Next if correct. Otherwise,
click on the Back buttons to make necessary corrections in earlier steps.
The next screen should show that the import was completed. Click the
View Log button and scan the log for any errors. If the import was
successful, you should see a message such as "The import process
completed successfully™ in the log:

Click Ok and then Finish.

You should now see the following STPs in the Utilities folder in a new
"Data Management" folder containing data management jobs:

ACCOUNTING_MEASURES

BSC1

DMOTHER
LOSS_TRIANGLE

RE_J1
RE_J2
RE_J3



TP E4
TP_E6

TP _E7A
TP _E7B

i. Import updated rmi_etl_bridge_m1_hf13.spk for the RMI Solution Data Mart
(SDM) ETL jobs

i.  Following is the summary of the newly added and modified jobs in this hot
fix:

Newly added jobs:

RMI_INT_100_| ACCOUNT_CREDIT_RISK_MITIGANT
RMI_INT_100_|_CREDIT_FACILITY_CR_MITIGANT
RMI_INT_100_|_EXPOSURE_CR_MITIGANT _RANK
RMI_INT_100_|_FINANCIAL_POSITION_CR_MITIGANT
RMI_INT_100_I|_FRA_INSTRUMENT _LEG
RMI_INT_100_I_RISK_FACTOR_X_RISK_FCTR_CURVE
RMI_STG_210_CLOSED_ASSET_DERIVATIVE
RMI_STG_210_CLOSED_ASSET DERIVATIVE_TRADE
RMI_STG_210_EXPOSURE_CRM_LINK
RMI_STG_210_GL_ACCOUNT_BALANCE_LOOP
RMI_STG 210 GL_BAL_SEGMENT ATTR_VAR
RMI_STG_210_GL_BALANCE_SEGMENT
RMI_STG_210_PORTFOLIO
RMI_STG_210_QUOTE_FUND

RMI_STG_210_ RATE_PARAM_GROUP_X_PARAMETER
RMI_STG_210_RI_CONTRACT COLLATERAL
RMI_STG_210_SEGMENTED_GL_ACCOUNT_BALANCE
RMI_STG_210_SEGMENTED_GL_ACCOUNT_BALANCE_LOOP
RMI_STG_210 SUB_LEDGER
RMI_STG_210_ENTITY_SYSTEM_IDENTITY
RMI_STG_210_LINE_OF BUSINESS_ASSOC
RMI_STG_230_CAPITAL_ALLOCATION
RMI_STG_230_CAPITAL_COST

Modified Jobs:

RMI_INT_100_|_ASSET_SGMNT_X_EXPOSURE
RMI_INT_100_|_BOND_INSTRUMENT
RMI_INT_100_|_COUNTERPARTY
RMI_INT_100_|_ CREDIT_CARD_ACCOUNT
RMI_INT_100_|_CREDIT_FACILITY
RMI_INT_100_|_CREDIT_RISK_MITIGANT
RMI_INT_100_| EXTERNAL_ORG
RMI_INT_100_|_FINANCIAL_INSTRUMENT
RMI_INT_100_I_FINANCIAL_POSITION
RMI_INT_100_|_FX_FORWARD_QUOTE



RMI_INT_100_|_FX_VOLATILITY_QUOTE
RMI_INT_100_|_INT_RATE_VOLATILITY_QUOTE
RMI_INT_100_|_INTEREST RATE_QUOTE
RMI_INT_100_|_PHYSICAL_ASSET RMI_INT_100_|_RISK_FACTOR
RMI_INT_100_|_PORTFOLIO
RMI_INT_100_|_REPO_INSTRUMENT
RMI_INT_100_|_RISK_FACTOR_X_RISK_FCTR_CURV
RMI_INT_100_| SWAP_INSTRUMENT LEG
RMI_INT_100_|_ COUNTERPARTY_CREDIT_ASSESSMENT
RMI_INT_105_I_FINANCIAL_ACCOUNT
RMI_INT_110_|_ACCT_POS_INST_FCLTY_APPEND
RMI_INT_110_|_QUOTE_VOLATILITY
RMI_STG_210_CEDED_LOSS
RMI_STG_210_CLAIM_HISTORY
RMI_STG_210_COUNTERPARTY_ASSOC
RMI_STG_210_COVERED_PERILS
RMI_STG_210_FINANCIAL_FUND
RMI_STG_210_JOIN_CUSTOMERS
RMI_STG_210_RI_CARRIER_X_RI_CONTRACT_SECTN
RMI_STG_210_FUND_INSTRUMENT
RMI_STG_210_GENERAL_INSURANCE_SUBJECT
RMI_STG_210 GENERAL_INSURANCE_UOE
RMI_STG_210_GL_ACCOUNT_ASSOC
RMI_STG_210_GL_ACCOUNT BALANCE
RMI_STG_210_INSURANCE_SEGMENT
RMI_STG_210_INSURED_ITEM_LOCATION
RMI_STG_210_INTERNAL_ORG_ASSOC
RMI_STG_210_LIFE_INSURANCE_POLICY
RMI_STG_210_REINSURANCE_CONTRACT_SECTION
RMI_STG_210_REINSURANCE_COVERAGE
RMI_STG_210_RI_CARRIER_X_XL_LAYER
RMI_STG_210_SECURITIZATION_POOL_MART
RMI_STG_210_SUB_LEDGER RMI_STG_210_XL_LAYER
RMI_STG_230_ASSET_SGMNT_X_EXPOSURE
RMI_STG_230_CDO_INSTRUMENT
RMI_STG_230_CASHFLOW_ACCOUNT
RMI_STG_230_CASHFLOW_FRA
RMI_STG_230_CASHFLOW_INSTRUMENT
RMI_STG_230_CONVERSION_SCHEDULE
RMI_STG_230_CONVERTIBLE_BOND_INSTRUMENT
RMI_STG_230_COUNTERPARTY
RMI_STG_230_COUNTERPARTY_RATINGS
RMI_STG_230_CREDIT_RISK_MITIGANT
RMI_STG_230_DISCRETE_CARRYING_COST
RMI_STG_230_EMBEDDED_OPTIONS
RMI_STG_230_FINANCIAL_CONTRACT
RMI_STG_230_FINANCIAL_CONTRACT _ISSUE
RMI_STG_230_FINANCIAL_EXPOSURE
RMI_STG_230_GL_ACCOUNT
RMI_STG_230_OPTION_INSTRUMENT
RMI_STG_230_OPTION_SCHEDULE



RMI_STG_230_QUOTE_FX

RMI_STG_230_QUOTE_INDEX

RMI_STG_230_QUOTE_IR

RMI_STG_230_QUOTE_IR RMI_STG_230_QUOTE_VOLATILITY
RMI_STG_230_QUOTE_VOLATILITY
RMI_STG_230_REPO_INSTRUMENT
RMI_STG_230_RF_CURVE_X_RF_GROUP
RMI_STG_230_RISK_DRIVER
RMI_STG_230_RISK_DRIVER_X_FIN_CONTR
RMI_STG_230_RISK_FACTOR RMI_STG_230_RISK_FACTOR_CURVE
RMI_STG_230_RISK_FACTOR_GROUP
RMI_STG_230_RISK_FACTOR_X_RISK_FCTR_CURVE
RMI_STG_230_SWAP_INSTRUMENT

Excluded Jobs:

RMI_INT_100_|_ASSET_SGMNT_X_EXPOSURE
RMI_STG_210_REINSURANCE_TREATY
RMI_STG_210_COUNTERPARTY_X_RI_TREATY
RMI_STG_210_CEDED_EXPOSURE
RMI_STG_210 RATE_PARAM_GROUP
RMI_STG_230_ASSET_PORTFOLIO_SEGMENT
RMI_STG_230_ASSET_SGMNT_X_EXPOSURE

If you already have existing RMI21.M1 ETL jobs, import the
rmi_etl_bridge_m1_hf13.spk file from

<SASHOME>/SASFoundation/9.2/SASRiskManagementForInsuranceMid
Tier/2.1/ETL folder as explained below.

Note: If RMI21.M1 ETL is not existing then first import rmi_etl_bridge.spk
from the same location.

Login to SAS DI Studio as the Administrator (sasadm) user

Click on the Folders tab

Navigate to the folder Products

Right-click on the Products folder and select Import SAS Package
from the menu

Browse to /SASRiskManagementForinsuranceMidTier/2.1/ETL and
select the rmi_etl_bridge_m1_hf13.spk file.

Select the radio button for All Objects and click Next.

Select the objects to Import and click Next

Click Next on ‘About metadata connections’ Screen

Select the target libraries that correspond to original libraries. Click
Next

Select the target tables that correspond to original tables. Click
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Next.
K. Ensure that you have the correct mappings for the SAS Application
Servers. Click Next.

L. Review the Summary information and click Next.

M. The next screen should show that the import was completed. Click
the View Log button and scan the log for any errors. If the import
was successful, you should see a message such as "The import
process completed successfully” in the log

N. Click Ok and then Finish.

O. Execute the below code in DI Studio to delete the metadata for

physically removed tables/columns.

The code below will synchronize table/column metadata as per physical structures.
(Assumption: All DDLs for current hot fix have been executed.)

In DI Studio, start the code editor from “Tools” menu and execute below code with
appropriate values of parameters.

Options metapass=""<password for metadata user>" metaport=<port
number>
metaprotocol=bridge metarepository=""foundation”
metaserver="<metadata server>"
metauser=""<metadata user id>";
proc metalib;
omr (library="RMI Staging” repname=""foundation”);
update_rule (delete noadd);
report;
run;

4. If required, selectively import metadata from the backup SPK (refer to Step 1) for
only those QRTs that were customized earlier and are not delivered in the hot fix.

Follow the steps below to regenerate the Solution Data Mart (SDM):

1. Locate the create_solution_data_mart.sas file in your install: in a typical install, the
macro resides under
<SASHOME>/SASFoundation/9.2/misc/rmicomnsvr/solution_data_mart

2. Open the create_solution_data_mart.sas file in a BASE SAS session on the
installation server (where the SAS code resides)

3. Scroll to the bottom of the macro file and comment out the following line:

%create_solution_data_mart(
soln_data_mart_dir=&sysparm,
fca_c_lib_nm=FINCAD_Suite_32_2011,



fea_c_lib_nm=intrlib,
run_tps_fincad_flag=N,
run_tps_fea_ flag=N);

4. Compile the macro in the SAS session by clicking the Submit button on the menu
5. After successful compilation, execute the following macro below:

%create_solution_data_mart(soln_data_mart_dir=<complete path to indata directory
in your install>);

Example of indata path:
<CONFIGDIR>/AppData/SASRiskManagementForInsurance/2.1/indata

6. Check the SAS log for successful execution of the preceding macro.
In addition, complete the following to recreate any shared entity data marts and
user directories.

7. Delete all user folders found in
<SASCONFIG>/Levl/AppData/SASRiskManagementForInsurance/2.1/data/userdata

Login to Risk Management for Insurance 2.1
Select File > Select Entity, choose an entity from the list, and click OK.
10. Re-create the shared data mart for that entity.

Select File > Manage Shared Data Mart from the menu and click Delete, then click
Create in the same Manage Shared Data Mart window.

11. Repeat steps 8 and 9 for each Entity.

G54010 for SAS Risk Reporting Repository 1.4 M1

Data model changes have been made to the SAS Risk Reporting Repository. You must update
the structures of the private RRR location and Shared location.

There are different ways in which to apply the new structure. Please select one of the following
methods that is applicable to your installation(s).

NB: In this release of the SAS Risk Reporting Repository previously marked deprecated
tables and/or columns have been removed from the model. The files for these structures may
still exist on your installation due to the delivery mechanism; however, code has been added
to ignore the pre-existing files when necessary.

NB: If the post-installation tasks for F12006 have been applied, the structures of the Private
locations will be automatically updated with the latest reportmart structure for the F120089
post- installation tasks and the subsequent methods are not necessary for applying the data
model changes to private RRR locations. The following methods can be applied to both the
private and shared locations depending on the state of your installation.

1. Updating via the provided sample data:



If a given reportmart location has not been updated by another process, creating the shipped
reportmart sample data in a given location will install the data model changes.

The shipped sample data scripts already contain the updates in the RRR data model/formats. If
you would like to utilize the shipped RMI sample data for the RRR without maintaining
existing data, create the RRR sample data using the following steps.

Note: The sample data creation script does not depend on the version of the original RRR that
is being overwritten. This script will overwrite the existing data and data model. For example,
if you are have the RRR 14 m1 version of the RRR and are installing the sixth RRR hotfix, by
creating the shipped sample data you do not need to install the "sample data for the previous
hotfix". The shipped sample data is a snapshot of the given version.

Submit the following code with your installation specific information. (Note: This has changed
from previous releases as you are now required to submit the rmiinit; prior to submitting the
batch program.)

options metauser=""<username>"" metapass=""<password>""
metaserver=""<server_name>"" metaport=<port_number> metarepository=""Foundation"’;

%rmiinit;

%rmi_batch_create_rrr_sample_data(
ENTITY=MAIN,

USERNAME=<username>,

CONFIG_SET_ID =SOLVENCY2 LVL2 OCT2011,
SCOPE=P);

* If you need to install the reportmart sample data to the Global RRR with the sample data
script, you must submit the following code with the additional information and changes:

%let rrr_user=<username>;
%let rrr_password=<Password>;

options metauser=""<username>"" metapass=""<password>""
metaserver=""<server_name>"" metaport=<port_number> metarepository=""Foundation™;
% rmiinit;
%rmi_batch_create_rrr_sample_data(ENTITY=MAIN,USERNAME=<username>,
CONFIG_SET_ID = SOLVENCY?2_LVL2_0OCT2011,

SCOPE=S);

NOTE: It is not recommended that you use this process on the Global RRR unless you are
absolutely certain of your specific installation needs. The script, as shown above, deletes the
Global RRR and replaces the location with the new version of the RRR with the shipped sample
data ONLY. All data in the Global location will be lost using this process.

2. Updating an existing install with alter/migration scripts:



If you have existing data in your reportmart and wish to only apply the data model changes,
execute the specific alter scripts for your given installations:

A. If the reportmart is the RRR14m1 version: execute %run_rrrl4ml _to_rrri4m1hfo.
Follow the instructions to execute this alter script in the PDF document
mlrrrl4_to_mlrrr14hf9_instructions.pdf that has been delivered with the alter scripts.
These files will be typically located in the following directory:

Win:
<SASHOME>/SASFoundation/9.2/rskrptmrtvrt/sasmisc/alterscripts/hotfix_9/m1_to_hotfix9

Unix:
<SASHOME>/SASFoundation/9.2/misc/rskrptmrtvrt/alterscripts/hotfix_9/m1_to_hotfix9

B. If the reportmart is the RRR14m1hfl version: execute %run_rrrl4mlhfl_to rrri4m1hfo.
Follow the instructions to execute this alter script in the PDF document
mlrrrl4hfl_to_mlrrr14hf8_instructions.pdf that has been delivered with the alter scripts.
These files will be typically located in the following directory:

Win:
<SASHOME>/SASFoundation/9.2/rskrptmrtvrt/sasmisc/alterscripts/hotfix_9/hotfix1_to_hotfix9

Unix:
<SASHOME>/SASFoundation/9.2/misc/rskrptmrtvrt/alterscripts/hotfix_9/hotfix1_to_hotfix9

C. If the reportmart is the RRR14m1hf2 version: execute %run_rrrl4m1hf2_to rrri4m1hfo.
Follow the instructions to execute this alter script in the PDF document
mlrrrl4hf2_to_mlrrr14hf9_instructions.pdf that has been delivered with the alter scripts.
These files will be typically located in the following directory:

Win:
<SASHOME>/SASFoundation/9.2/rskrptmrtvrt/sasmisc/alterscripts/hotfix_9/hotfix2_to_hotfix9
Unix:
<SASHOME>/SASFoundation/9.2/misc/rskrptmrtvrt/alterscripts/hotfix_9/hotfix2_to_hotfix9

D. If the reportmart is the RRR14m1hf3 version: execute %run_rrr14m1hf3_to_rrr14m1hf9.
Follow the instructions to execute this alter script in the PDF document
mlrrr14hf3_to_mlrrr14hf8_instructions.pdf that has been delivered with the alter scripts.
These files will be typically located in the following directory:

Win:
<SASHOME>/SASFoundation/9.2/rskrptmrtvrt/sasmisc/alterscripts/hotfix_9/hotfix3_to_hotfix9

Unix:
<SASHOME>/SASFoundation/9.2/misc/rskrptmrtvrt/alterscripts/hotfix_9/hotfix3_to_hotfix9



E. If the reportmart is the RRR14m1hf4 version: execute %run_rrrl4mlhf4_to rrri4m1hfo.
Follow the instructions to execute this alter script in the PDF document
mlrrrl4hf4_to_mlrrr14hf8_instructions.pdf that has been delivered with the alter scripts.
These files will be typically located in the following directory:

Win:
<SASHOME>/SASFoundation/9.2/rskrptmrtvrt/sasmisc/alterscripts/hotfix_9/hotfix4_to_hotfix9

uUnix:
<SASHOME>/SASFoundation/9.2/misc/rskrptmrtvrt/alterscripts/hotfix_9/hotfix4_to_hotfix9

F. If the reportmart is the RRR14m1hf5 version: execute %run_rrr14m1hf5_to_rrr14m21hf9.
Follow the instructions to execute this alter script in the PDF document
mlrrrl4hf5_to_mlrrr14hf8_instructions.pdf that has been delivered with the alter scripts.
These files will be typically located in the following directory:

Win:
<SASHOME>/SASFoundation/9.2/rskrptmrtvrt/sasmisc/alterscripts/hotfix_9/hotfix5_to_hotfix9

Unix:
<SASHOME>/SASFoundation/9.2/misc/rskrptmrtvrt/alterscripts/hotfix_9/hotfix5_to_hotfix9

G. If the reportmart is the RRR14m1hf6 version: execute %run_rrrl4m1hf6_to_rrr14m21hf9.
Follow the instructions to execute this alter script in the PDF document
mlrrrl4hf6_to_mlrrrl4hf9_instructions.pdf that has been delivered with the alter scripts.
These files will be typically located in the following directory:

Win:
<SASHOME>/SASFoundation/9.2/rskrptmrtvrt/sasmisc/alterscripts/hotfix_9/hotfix6_to_hotfix9

uUnix:
<SASHOME>/SASFoundation/9.2/misc/rskrptmrtvrt/alterscripts/hotfix_9/hotfix6_to_hotfix9

H. If the reportmart is the RRR14m1hf7 version: execute %run_rrrl4m1hf7_to_rrr14m21hf9.
Follow the instructions to execute this alter script in the PDF document
mlrrrl4hf7_to_mlrrr14hf9_instructions.pdf that has been delivered with the alter scripts.
These files will be typically located in the following directory:

Win:
<SASHOME>/SASFoundation/9.2/rskrptmrtvrt/sasmisc/alterscripts/hotfix_9/hotfix7_to_hotfix9

uUnix:
<SASHOME>/SASFoundation/9.2/misc/rskrptmrtvrt/alterscripts/hotfix_9/hotfix7_to_hotfix9

I. If the reportmart is the RRR14m1hf8 version: execute %run_rrr14m1hf8_to_rrr14m1hf9.
Follow the instructions to execute this alter script in the PDF document



mlrrrl4hf8 to_mlrrrl4hf9 _instructions.pdf that has been delivered with the alter scripts. These
files will be typically located in the following directory:

Win:
<SASHOME>/SASFoundation/9.2/rskrptmrtvrt/sasmisc/alterscripts/hotfix_9

Unix:
<SASHOME>/SASFoundation/9.2/misc/rskrptmrtvrt/alterscripts/hotfix_9

3. Installing a new reportmart using the ddls/createrrr.sas script:

If you would like to create a new RRR with the new data model, follow the instructions for
installing a clear RRR in the Installing and Configuring the SAS Risk Reporting Repository
section in the SAS Risk Reporting Repository 1.4 Reference Guide, Second Edition.

F92012 for SAS Underwriting Risk Management for Life Insurance Server 2.1_M1

NONE

F91012 for SAS Underwriting Risk Management for P&C Insurance Server 2.1_M1
NONE

G61009 for SAS Risk Management for Insurance Mid-Tier 2.1_M1

If both F90006 and F90007 have been previously installed, the steps below can be skipped
in their entirety.

Re-build and Re-deploy Web Application

This hot fix requires that the Web Application be rebuilt and redeployed. Use the following
steps to perform this post-installation task:

Step 1: Re-build Web Application
In order for this step to execute correctly, the Metadata Server must be running.
1.1 Invoke the SAS Deployment Manager 9.2

From the SASDeploymentManager directory launch config.exe.
SAS Deployment Manager is installed in the following default location:

<SASHOME>/SASDeploymentManager/9.2

1.2 Select a language in the Choose Language box



1.3 Select Rebuild Web Applications

1.4 Select Configuration Directory or Enter the Configuration Directory and Level that needs
to be updated

1.5 Specify Connection Information, including the sasadm User ID and Password
1.6 Select Risk Management for Insurance as the Web Application to Rebuild
1.7 Verify the information on the Summary screen and select Start

1.8 Select Finish when the deployment is complete

This process will update the Risk Management for Insurance ear in
<SASCONFIGDIR>/Web/Staging.

A backup of the original ear file will be placed in the directory below:
<SASCONFIGDIR/Web/Staging/Backup

Step 2: Re-deploy Web Applications

Re-deploy the web applications based on the instructions for the web application server you
are using.

Re-start the application (or the application server) using your application server’s admin
console.

Before accessing the web application, empty the Temporary Internet files location on the

client machine used to access the web application from. This is a precautionary measure to
avoid problems due to caching of older files in the internet browser.

This completes the installation of hot fix F90012 on Linux for x64.
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